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1 Introduction 

1.1 PolaRxS Concept 

The PolaRxS is a multi-frequency multi-constellation receiver dedicated to ionospheric monitoring 

and space weather applications. 

  

The PolaRxS incorporates a state-of-the-art triple-frequency receiver engine and an ultra low noise 

OXCO frequency reference in a rugged housing. The housing provides a multitude of interfaces 

including USB and Ethernet. 

 

An intuitive User Graphical Interface is provided for data logging and remote control. Specifically for 

space weather and ionosphere monitoring applications, the logging tool (RxLogger) supports 

continuous TEC and scintillation indices logging and monitoring. Available indices include the S4, , 

spectral slope and SI indexes for all satellite constellations and frequency bands. 

 

1.2 High-Level Operation Overview 

In a typical setup, the receiver generates and outputs 50-Hz phase and amplitude samples for all visible 

satellites and frequency bands.  These samples are logged on a host PC in hourly files using the 

provided RxLogger graphical interface.  At the end of every hour, TEC and scintillation indices are 

computed for all visible satellites and logged as comma-delimited ASCII records. 

 

The receiver can also output S4 and  indices in real time for all tracked satellites. 

1.3 About this Manual 

This manual covers the configuration of the PolaRxS receiver and of the RxLogger tool for 

ionospheric scintillation and TEC monitoring. 

 

Chapter 2 of this document covers the typical configuration of the RxLogger tool.   

 

Chapter 3 provides details on the sbf2ismr command line program and on the format of the ISMR 

output files. ISMR files contain Ionospheric Scintillation Monitoring Records (ISMR) logged every 

minute for all tracked satellites.  

 

The appendices provide further information on operating the receiver at 100-Hz rate, on the real-time 

S4 and output and on the TEC calibration tool built in sbf2ismr. 

 

Additional relevant documentation can be found in the following manuals: 

 The Firmware User Manual describes the operation principle of the receiver and provides 

how-to’s to help configuring the receiver in a selected set of applications. 

 The Command Line Interface Reference Guide describes the the user command set. 

 The SBF Reference Guide describes the Septentrio binary format (SBF). 

 The PolaRxS Product Family Hardware Manual contains a description of the PolaRxS 

connectors and mechanical characteristics. 

 The RxControl Manual covers the RxTools software suite, including RxControl and 

RxLogger. 
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2 Typical RxLogger Configuration 

2.1 Connecting To the Receiver 

The first time you run RxLogger, you need to create a new connection.  The next times, RxLogger will 

by default reuse the last connection, so that the connection creation must only be done once.  

 

Refer to the RxControl Manual for a complete description of the connection options.  

 

 It is recommended to use one of the two Virtual USB COM ports (see below) connections to connect 

RxLogger to the receiver.  A TCP/IP (Ethernet) connection is also possible but, depending on your 

network topology, may lead to occasional data gaps when logging at high rate. Standard serial ports 

should not be used because their bandwidth is too low to support the high-rate data required for 

ionospheric scintillation monitoring.  

 

 

 
 

2.2 Configuring the Receiver 

For scintillation monitoring, it is recommended to configure the receiver such that: 

 the frontend automatic gain control (AGC) is turned off; 

 the adaptive tracking loop parameters are turned off; 

 the C/N0 mask is reduced. 

 

One of the ways to do so is to ask RxLogger to send a “startup script” to the receiver before the 

logging starts.  A startup script is a text file containing a list of user commands, one command per line.  

It is recommended that the startup script would contain the following lines: 

 
setAGCMode,all,frozen 

setTrackingLoopParameters,all,,,,,off 

setCN0Mask,all,15 

 

Please refer to the Command Line Interface Reference Guide for a description of these three 

commands. 
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In the main window of RxLogger, select the “Global” tab and enter the location of the startup script as 

shown below. 

 

 

2.3 Configuring File Names and Directories 

You need to specify where to store the raw data from the receiver.  Raw data (high-rate phase and 

amplitude and low-rate support data) are stored in the Septentrio-proprietary SBF format.  Raw data 

files are referred to as “SBF files” in the sequel of this document. 

 

In the main window of RxLogger, select the “Global” tab and make sure that the Log Directory points 

to the folder where the SBF files must be logged.  In the screen shot shown below, we want all data to 

be stored under o:\all\. 
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Now select the “File Naming” tab, and set the file naming convention to one of the IGS options. For 

example, select “IGS 1 hour”: this will cause RxLogger to create hourly SBF files.  

 

A new directory will be created every day under the directory specified under the “Global” tab, with 

the name being formed by the concatenation of the two-digit year number and the 3-digit day-of-year. 

Within each of the daily directories, the hourly SBF files follow the IGS file naming convention: 
 

   ssssdddf.yy_ 

   |   |  | |  

   |   |  | |  

   |   |  | | 

   |   |  | +---  yy:  two-digit year 

   |   |  | 

   |   |  +-----   f:  file sequence character within day 

   |   |               A:  1st hour 00h-01h; B: 2nd hour 01h-02h; ... 

   |   |               X: 24th hour 23h-24h 

   |   | 

   |   +-------  ddd:  day of the year of first record in file 

   | 

   +----------- ssss:  4-character station name designator 

 

The “ssss” field (the station name designator) can be freely chosen by the user by checking “Force the 

MarkerName to:”.  In the example shown below, the “ssss” field is set to “SEPT”. 
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The screen shot below shows an exemplary directory contents corresponding to January 19, 2008.  The 

files with the “.08_” extension are SBF files containing the raw data from the receiver.  The files 

with the “.08_.ismr” extension are the post-processed files containing the scintillation indices (see 

later in section 2.5 how to configure the post-processing actions). 
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2.4 Configuring the Set of Raw Data to Log 

Raw data in the SBF format are arranged in so-called SBF blocks and you need to tell RxLogger 

which blocks to log and at which interval.  This is done under the “SBF” tab of the main window of 

RxLogger.  For ionospheric scintillation and TEC monitoring, the following SBF blocks must be 

logged: 

 

 At an interval of 20ms (50Hz): 

o IQCorr  

 At an interval of 1s (1Hz)1: 

o MeasEpoch 

o MeasExtra 

 At an interval of 10s: 

o ReceiverStatus 

o ChannelStatus 

o ReceiverSetup 

 At an interval of “onchange”: 

o GPSNav 

o GLONav 

o GALNav 

o CMPNav 

o QZSNav 

 

                                                      
1 It is not needed to log the MeasEpoch and MeasExtra SBF blocks at 50-Hz.  A 1-Hz rate is 

recommended for these blocks to reduce the CPU burden and minimize the file size. 
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Click the “Add Stream” button to add a new column in the window.  A column contains all the blocks 

that need to be logged at a certain interval. 

 

   
 

 

2.5 Configuring the Post Processing Options 

The SBF files do not contain the scintillation indices.  To compute these indices from the SBF file, you 

need to use the sbf2ismr conversion program.  RxLogger can automatically call that program at 

each hour boundary, and let it run over the file collected during the last hour. To do this, you define a 

post-processing action under the “Post Processing” tab of the main window of RxLogger. 

 

Refer to Chapter 3 for a detailed description of the sbf2ismr conversion program.  
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Click the “Add” button to add a post-processing action.  The following window appears, where you 

need to select SBF ISMR Conversion. 

 

 
 

Click “Next” to see the ISMR conversion options. 

 



 _____________________________________________________________________ 2    Typical RxLogger Configuration 

 

PolaRxS Application Manual v2.5.0  13 

 
 

Select the phase detrending cut-off frequency as desired (default is 0.10Hz).   

 

You may want to reduce the number of columns in the ISMR file, for example if you are only 

interested in single-frequency indices.  Refer to section 3.1.3 for details. 

 

It is also possible to exclude one or more constellations from the ISMR file, even if data from satellites 

from these constellations are available in the SBF file. 

 

Optionally, you can provide a TEC calibration file in order to correct for TEC biases.  See section 

3.1.8 for details. 

 

Click “Next” to go to the “Compression Type” window, where you can select which compression to 

apply to the ISMR file.  As these files are typically small (<200kbytes), it is typical not to apply any 

compression. 
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Clicking “Next” brings you to the “Output File Destination” window, where you can configure an 

automatic FTP of the freshly created ISMR file to a remote FTP server.  Just click next to simply leave 

the ISMR files at their default location, i.e. in the same directory as the raw SBF files. 
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Finally, you are offered to choose a name for the post-process action and to add some textual details.  

The name that you type here is for information purpose only. 

 

 
 

Click “Finish” and you will see the “sbf2ismr conversion” action appearing in the list of post 

processing actions. 

 

You may now click “Start Logging” to start logging. 

 

2.6 Controlling the Logging and ISMR Status 

Under the “Status” tab of the main window of RxLogger, you can follow the progress of the logging 

and post-processing and get a snapshot of the ISMR indices.  
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At any time, logging can be stopped by clicking “Stop Logging”. 

2.7 Compressing the Raw SBF files 

The hourly SBF files are typically very large.  RxLogger can automatically compress these files.  To 

do this, you define another post-processing action under the “Post Processing” tab of the main window 

of RxLogger. 

 

 
 

Click the “Add” button to add a new post-processing action.  In the Post Process Action Input and 

Type window, just click “Next” as there is no conversion to apply, but only a compression. 
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You can now select the compression program to use.  Click “Next” to enter the “Output File 

Destination” window, where you typically click “Next” again.  You can now enter a textual description 

of this new post-processing action and click “Finish”. 

 

 
 

Make sure to check the “Remove Source Files” box, in order to delete the original (non compressed) 

SBF file.  
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2.8 Exiting and Restarting RxLogger 

When exiting and restarting RxLogger, all the user settings are maintained (they are stored in the file 

.septentrio/rxlogger.conf under the user’s home directory), so that the configuration steps 

described above only need to be executed once. 

2.9 Starting RxLogger from the Command Line 

It is possible to launch rxlogger from the command line, as shown below under Windows XP. 

 

 
 

Rxlogger starts in the configuration as stored in the rxlogger.conf file.  The –A command line 

option causes RxLogger to immediately start logging without any user interaction. 

The command “rxlogger –A” can be included in a boot script on the host PC to automatically start 

RxLogger at each boot. 
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3 sbf2ismr Program 
The sfb2ismr program converts a binary SBF file containing 50- or 100-Hz raw correlation and 

phase data into an ASCII ISMR file containing ionospheric scintillation and TEC indices.  In addition, 

sbf2ismr can also produce an ASCII file containing the unprocessed 50- or 100-Hz raw correlations 

and phase data.  From version 7.0.0, sbf2ismr can also be used for TEC calibration. 

 

sbf2ismr is a command line tool.  Both a Windows and a Linux version are provided.  Typically,  

sbf2ismr is automatically started from RxLogger at the end of every hourly file, but it can also be 

manually called at any time to get an instant overview of the scintillation indices, or to reprocess the 

raw high-rate data. 

 

The output ISMR file contains comma-delimited ASCII records for all satellites in view and for every 

minute.  An exemplary set of records is shown below: 

 

 
 

Invoking sbf2ismr with the –h option prints the help screen, including the definition of all the 

fields (or columns) in a record: 

 
sbf2ismr is a utility to convert the data in a SBF file into ASCII ionospheric scintillation 

monitoring records.  The SBF file needs to contain the following SBF blocks at at least 

the specified interval: 

    IQCorr,         20ms 

    MeasEpoch,      1s 

    MeasExtra,      1s 

    ReceiverStatus, 10s 

    ChannelStatus,  10s 

    ReceiverSetup,  10s 

    GPSNav,         OnChange 

    GALNav,         OnChange 

    CMPNav,         OnChange 

    QZSNav,         OnChange 

 

Command line options: 

 

sbf2ismr -f InputFile [-o ISMRFile][-p PreviousFile][-x Systems][-c DetFreq] 

                      [-n NoCols][-S][-r RawFile][-g][-b StartEpoch] 

                      [-e EndEpoch][-V][-h] 

 

  -f InputFile :  (mandatory) Name of the input SBF file. 

  -o ISMRFile :   Name of the output file containing the ISMR records (see 

                  format below). 

                  This argument is optional.  If not provided, the output file 

                  name is the same as the input file name, with the extension 

                  .ismr being added. See below the format of the ISMR file. 

  -p PrevFile :   Name of the previous input file, i.e. name of the SBF file 

                  logged just before input_file.  The last epochs of the 

                  previous file are used to initialize the detrending filters. 

                  If there is no previous file, skip this option or use NA as 

                  PrevFile. 

  -C TECCalFile:  Name of the TEC calibration input file (see format below). 

  -x Systems:     Exclude one or more satellite systems from the observation 

                  file. Systems may be G (GPS), R (Glonass), E (Galileo), 

                  S (SBAS), C (Compass), J (QZSS) or any combination thereof.  For 

                  instance -xERSCJ produces a GPS-only observation file. 

  -c DetFreq :    Cutoff frequency of the carrier phase detrending filter 

                  (6th order high pass butterworth).  Units of Hz. Valid values 

                   range from 0.01 to 1.0 Hz, default 0.1Hz. 

  -n NoCols :     Only output the first NoCols in the output file (see column 

                  format below). 

1462,540300, 11,00000074, 27,15,48.2, 0.029, 0.000, 0.017, 0.023, 0.028, 0.028, 0.028,  2.397, 0.071, 18.811, 0.042, 18.830, 0.044, 18.782, 0.055, 19.934, 0.033, 3581,0, 3578,37.5,  0.8 
1462,540300, 10,00000074,232,29,48.2, 0.049, 0.030, 0.026, 0.032, 0.036, 0.036, 0.036, -3.606, 0.066, 13.851,-0.031, 14.099,-0.026, 14.384,-0.021, 14.061,-0.032, 4210,0, 4202,37.6,  1.5 
1462,540300, 23,00000074,232,68,48.2, 0.039, 0.007, 0.023, 0.029, 0.033, 0.033, 0.034, -5.799, 0.073,  7.283, 0.004,  5.559,-0.003,  7.273, 0.013,  5.864,-0.006,11894,0,11888,37.6,  1.3 
1462,540300, 17,00000074,152,15,48.2, 0.039, 0.006, 0.020, 0.026, 0.030, 0.030, 0.031, -1.774, 0.056, 18.259, 0.010, 19.839, 0.014, 19.230, 0.006, 19.458, 0.006,22381,0,22376,37.7,  1.1 
1462,540300,  1,00000074,344,23,48.2, 0.030, 0.000, 0.018, 0.024, 0.029, 0.029, 0.029, -2.851, 0.061, 16.669,-0.041, 17.002,-0.032, 16.412,-0.035, 17.973,-0.036, 3761,0, 3752,37.5,  0.9 
1462,540300,  2,00000074, 17,45,48.2, 0.041, 0.012, 0.019, 0.025, 0.030, 0.030, 0.030, -1.537, 0.168, 10.215,-0.019, 10.976,-0.024, 10.329,-0.014, 10.548,-0.021, 2981,0, 2977,37.6,  1.1 
1462,540300, 15,00000074, 85,37,48.2, 0.029, 0.000, 0.017, 0.023, 0.028, 0.029, 0.029, -4.356, 0.062,  9.643, 0.008, 10.691, 0.002, 10.748,-0.002, 11.128, 0.007,29080,0,29072,37.7,  0.9 
1462,540300, 24,00000074,170,47,48.2, 0.029, 0.000, 0.016, 0.022, 0.028, 0.028, 0.028, -5.024, 0.053,  8.872, 0.012,  8.882, 0.023,  9.082, 0.023,  9.253, 0.024,17000,0,16994,37.7,  0.8 
1462,540300,  8,00000074,308,16,48.2, 0.031, 0.000, 0.017, 0.023, 0.029, 0.029, 0.029, -1.904, 0.054, 17.773,-0.001, 19.134,-0.002, 17.611, 0.006, 18.916, 0.002,10137,0,10130,37.6,  0.9 
1462,540360, 11,00000074, 27,15,48.0, 0.028, 0.000, 0.016, 0.022, 0.028, 0.029, 0.030,  2.446, 0.048, 18.906, 0.060, 18.744, 0.038, 19.020, 0.052, 18.954, 0.049, 3641,0, 3638,37.6,  0.8 
1462,540360, 10,00000074,232,30,48.0, 0.045, 0.022, 0.019, 0.024, 0.030, 0.031, 0.031, -3.654, 0.047, 14.184,-0.022, 13.899,-0.027, 13.575,-0.021, 14.460,-0.017, 4270,0, 4262,37.6,  1.4 
1462,540360, 23,00000074,231,68,48.0, 0.039, 0.000, 0.018, 0.023, 0.029, 0.031, 0.031, -5.799, 0.074,  6.616, 0.005,  7.006, 0.003,  6.473, 0.005,  8.339, 0.010,11954,0,11948,37.7,  1.2 
1462,540360, 17,00000074,152,15,48.0, 0.037, 0.000, 0.017, 0.022, 0.028, 0.030, 0.030, -1.734, 0.073, 17.887, 0.019, 19.591, 0.008, 19.468, 0.007, 18.697, 0.012,22441,0,22436,37.7,  1.0 
1462,540360,  1,00000074,344,23,48.0, 0.030, 0.000, 0.017, 0.022, 0.029, 0.030, 0.030, -2.863, 0.055, 15.289,-0.029, 15.365,-0.043, 15.641,-0.035, 15.774,-0.034, 3821,0, 3812,37.6,  0.8 
1462,540360,  2,00000074, 17,45,48.0, 0.042, 0.014, 0.019, 0.024, 0.030, 0.032, 0.032, -1.521, 0.059,  9.843,-0.012,  8.758,-0.018,  9.605,-0.017,  9.615,-0.015, 3041,0, 3037,37.6,  1.2 
1462,540360, 15,00000074, 85,37,48.0, 0.029, 0.000, 0.016, 0.022, 0.028, 0.029, 0.030, -4.354, 0.052, 11.167, 0.007, 11.852,-0.000, 12.414, 0.010, 10.929, 0.006,29140,0,29132,37.7,  0.8 
1462,540360, 24,00000074,170,46,48.0, 0.030, 0.000, 0.017, 0.022, 0.028, 0.029, 0.030, -5.017, 0.062, 10.205, 0.017,  9.482, 0.025,  8.596, 0.017,  9.205, 0.026,17060,0,17054,37.7,  0.9 
1462,540360,  8,00000074,309,16,48.0, 0.032, 0.000, 0.018, 0.022, 0.028, 0.030, 0.030, -1.926, 0.069, 17.764, 0.004, 18.354, 0.001, 17.802, 0.002, 19.268, 0.002,10197,0,10190,37.6,  0.9 
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  -S :            Do not generate the ISMR file, but still print the status 

                  screen. 

  -g :            When computing TEC, do not correct for satellite inter-frequency 

                  biases, i.e. ignore the group delay corrections transmitted by 

                  the satellites in their navigation message. 

  -r RawFile :    Name of the "raw file" containing the raw data 

                  (carrier phase and correlations) in ASCII format.  This 

                  argument is optional.  If not provided, the raw file is 

                  not created. See below the format of the raw file. 

  -b StartEpoch   Time of first epoch to parse from the SBF file (in GPS time 

                  scale). Format: yyyy-mm-dd_hh:mm:ss. 

  -e EndEpoch     Time of last epoch to parse from the SBF file (in GPS time 

                  scale). Format: yyyy-mm-dd_hh:mm:ss. 

  -as             Do not generate ISMR data, but print TEC calibration values using 

                  the SBAS ionospheric corrections as reference. 

  -ak             Do not generate ISMR data, but print TEC calibration values using 

                  the Klobuchar ionospheric model as reference. 

  -V :            Display the version of sbf2ismr. 

  -h :            Display this help screen. 

 

 

Format of the ISMR output file 

------------------------------ 

 

  Note: "Sig1" means L1CA for GPS/GLONASS/SBAS/QZSS, L1BC for GALILEO, B1 for COMPASS. 

        "Sig2" means L2C for GPS/GLONASS/QZSS, E5a for GALILEO, L5 for SBAS, B2 for COMPASS. 

        "Sig3" means L5 for GPS/QZSS or E5b for GALILEO. 

 

Col  1: WN, GPS Week Number 

Col  2: TOW, GPS Time of Week (seconds) 

Col  3: SVID 

Col  4: Value of the RxState field of the ReceiverStatus SBF block 

Col  5: Azimuth (degrees) 

Col  6: Elevation (degrees) 

Col  7: Average Sig1 C/N0 over the last minute (dB-Hz) 

Col  8: Total S4 on Sig1 (dimensionless) 

Col  9: Correction to total S4 on Sig1 (thermal noise component only) (dimensionless) 

Col 10: Phi01 on Sig1,  1-second phase sigma (radians) 

Col 11: Phi03 on Sig1,  3-second phase sigma (radians) 

Col 12: Phi10 on Sig1, 10-second phase sigma (radians) 

Col 13: Phi30 on Sig1, 30-second phase sigma (radians) 

Col 14: Phi60 on Sig1, 60-second phase sigma (radians) 

Col 15: AvgCCD on Sig1, average of code/carrier divergence (meters) 

Col 16: SigmaCCD on Sig1, standard deviation of code/carrier divergence (meters) 

Col 17: TEC at TOW-45s (TECU), taking calibration into account (see -C option) 

Col 18: dTEC from TOW-60s to TOW-45s (TECU) 

Col 19: TEC at TOW-30s (TECU), taking calibration into account (see -C option) 

Col 20: dTEC from TOW-45s to TOW-30s (TECU) 

Col 21: TEC at TOW-15s (TECU), taking calibration into account (see -C option) 

Col 22: dTEC from TOW-30s to TOW-15s (TECU) 

Col 23: TEC at TOW (TECU), taking calibration into account (see -C option) 

Col 24: dTEC from TOW-15s to TOW (TECU) 

Col 25: Sig1 lock time (seconds) 

Col 26: sbf2ismr version number 

Col 27: Lock time on the second frequency used for the TEC computation (seconds) 

Col 28: Averaged C/N0 of second frequency used for the TEC computation (dB-Hz) 

Col 29: SI Index on Sig1: (10*log10(Pmax)-10*log10(Pmin))/(10*log10(Pmax)+10*log10(Pmin)) (dimensionless) 

Col 30: SI Index on Sig1, numerator only: 10*log10(Pmax)-10*log10(Pmin) (dB) 

Col 31: p on Sig1, spectral slope of detrended phase in the 0.1 to 25Hz range (dimensionless) 

Col 32: Average Sig2 C/N0 over the last minute (dB-Hz) 

Col 33: Total S4 on Sig2 (dimensionless) 

Col 34: Correction to total S4 on Sig2 (thermal noise component only) (dimensionless) 

Col 35: Phi01 on Sig2,  1-second phase sigma (radians) 

Col 36: Phi03 on Sig2,  3-second phase sigma (radians) 

Col 37: Phi10 on Sig2, 10-second phase sigma (radians) 

Col 38: Phi30 on Sig2, 30-second phase sigma (radians) 

Col 39: Phi60 on Sig2, 60-second phase sigma (radians) 

Col 40: AvgCCD on Sig2, average of code/carrier divergence (meters) 

Col 41: SigmaCCD on Sig2, standard deviation of code/carrier divergence (meters) 

Col 42: Sig2 lock time (seconds) 

Col 43: SI Index on Sig2 (dimensionless) 

Col 44: SI Index on Sig2, numerator only (dB) 

Col 45: p on Sig2, phase spectral slope in the 0.1 to 25Hz range (dimensionless) 

Col 46: Average Sig3 C/N0 over the last minute (dB-Hz) 

Col 47: Total S4 on Sig3 (dimensionless) 

Col 48: Correction to total S4 on Sig3 (thermal noise component only) (dimensionless) 

Col 49: Phi01 on Sig3,  1-second phase sigma (radians) 

Col 50: Phi03 on Sig3,  3-second phase sigma (radians) 

Col 51: Phi10 on Sig3, 10-second phase sigma (radians) 

Col 52: Phi30 on Sig3, 30-second phase sigma (radians) 

Col 53: Phi60 on Sig3, 60-second phase sigma (radians) 

Col 54: AvgCCD on Sig3, average of code/carrier divergence (meters) 

Col 55: SigmaCCD on Sig3, standard deviation of code/carrier divergence (meters) 

Col 56: Sig3 lock time (seconds) 

Col 57: SI Index on Sig3 (dimensionless) 

Col 58: SI Index on Sig3, numerator only (dB) 

Col 59: p on Sig3, phase spectral slope in the 0.1 to 25Hz range (dimensionless) 

Col 60: T on Sig1, phase power spectral density at 1 Hz (rad^2/Hz) 

Col 61: T on Sig2, phase power spectral density at 1 Hz (rad^2/Hz) 

Col 62: T on Sig3, phase power spectral density at 1 Hz (rad^2/Hz) 

 

 

Format of the raw ASCII output file (option -r) 

----------------------------------------------- 
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Col  1: TOW, GPS Time of Week (seconds) 

Col  2: SVID 

Col  3: Signal type:  0=GPS_L1CA,  3=GPS_L2C,  4=GPS_L5, 

                      8=GLO_L1CA, 11=GLO_L2CA, 

                     17=GAL_L1BC, 20=GAL_E5a, 21=GAL_E5b, 22=GAL_AltBOC, 

                     24=GEO_L1CA, 25=GEO_L5 

                      6=QZS_L1CA,  7=QZS_L2C, 26=QZS_L5, 

                     28=CMP_B1,   29=CMP_B2 

Col  4: Carrier phase (cycles) 

Col  5: I correlation (dimensionless) 

Col  6: Q correlation (dimensionless) 

 

 

Format of the TEC calibration input file (option -C) 

---------------------------------------------------- 

 

The TEC calibration file is a text file that can be provided as input to 

sbf2ismr to correct for TEC biases. 

Each line of the file must contain a satellite identifier (RINEX convention) 

followed by the TEC calibration value in TECU for that particular satellite. 

It is possible to apply the same calibration value to all satellites of a 

constellation by replacing the satellite number by wildcards. 

If the calibration value is set to 'NA', no TEC is computed for the specified 

satellite. 

If the same satellite is addressed multiple times in the file, only the last 

entry is taken into account. 

Comments can be added by preceding them with a '#' character. 

Example of a valid calibration file: 

 

#This is a comment 

E12 9.45 

R03 -0.3 

G** 2.4 

G21 2.8 

S** NA 

 

With this file, the TEC calibration value is 9.45TECU for Galileo E12, -0.3TECU 

for GLONASS R03, 2.4 for all GPS satellites except G21 where it is 2.8TECU.  TEC 

should not be computed for SBAS satellites (calibration value set to 'NA').  For 

all satellites not addressed in the calibration file, the TEC calibration value 

is assumed to be zero. 

Corrected TEC values are obtained by subtracting the TEC calibration value 

from the raw TEC.  The ISMR file contains corrected values. 

 

3.1 ISMR Record Details 

3.1.1 Time Tag 

The first two columns contain the week number and time-of-week.  The time scale is GPS time, even 

for non-GPS satellite records. 

 

3.1.2 Supported Satellites 

ISMR records are generated every minute for all satellites tracked by the receiver. 

   

The SVID column identifies the satellite.  The range of possible values for SVID is as follows: 
 
 1 -  37 : PRN number of a GPS satellite 

 38 -  61 : Slot number of a GLONASS satellite, with an offset of 37 

 71 -  102 : PRN number of a GALILEO satellite, with an offset of 70 
120 - 140 : PRN number of an SBAS satellite 

141 - 172 : PRN number of a COMPASS/BEIDOU satellite, with an offset of 140 

181 - 187 : PRN number of a QZSS satellite, with an offset of 180 

 

The value “62” is used for GLONASS satellites of which the slot number is not known. 

 

3.1.3 Number of Columns 

By default, the ISMR file contains 62 columns, i.e. 62 values for each satellite every minute. 

 

It is possible to specify the number of columns to include in the ISMR file by using the –n option of 

sbf2ismr.  For example, a user only interested in the satellite azimuth and elevation (columns 5 and 

6) could use the option –n6 to skip all columns after the 6th one. 
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3.1.4 Not Applicable Values 

 

Not applicable columns or fields of which the value is unknown contain the “nan” string (not-a-

number).   

 

 

3.1.5 S4 index 

 

The total S4 (columns 8, 33 and 47) is the standard deviation of the 50-Hz raw signal power 

normalized to the average signal power over the last minute. 

 

The S4 correction (columns 9, 34 and 48) accounts for the thermal noise contribution in the total S4. 

 

A corrected S4 (i.e. without the thermal noise contribution) can be computed as follows: 

  

𝑋 = 𝑆4𝑡𝑜𝑡𝑎𝑙
2 − 𝑆4𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑖𝑜𝑛

2

𝑆4𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 = {
√𝑋𝑖𝑓 𝑋 > 0

0 𝑖𝑓 𝑋 ≤ 0

 

 

 

 

3.1.6 Phixx Indexes 

The Phixx indexes (columns 10 to 14, 35 to 39 and 49 to 53) contain the standard deviation, in radians, 

of the 50-Hz detrended carrier phase averaged over intervals of 1, 3, 10, 30 and 60 seconds.  More 

specifically: 

 

 Phi01 is the average of the 60 standard deviations computed over 1-s intervals during the last 

minute. 

 Phi03 is the average of the 20 standard deviations computed over 3-s intervals during the last 

minute. 

 Phi10 is the average of the 6 standard deviations computed over 10-s intervals during the last 

minute. 

 Phi30 is the average of the 2 standard deviations computed over 30-s intervals during the last 

minute. 

 Phi60 is the standard deviation computed over the whole last minute. 

 

The phase detrending is done by filtering the raw 50-Hz carrier phase measurements by a 6th order 

Butterworth high-pass filter.  The cutoff frequency of that filter is user selectable with the –c option of 

sbf2ismr. 

 

 

3.1.7 Code-Phase Divergence 

 

Columns 15-16, 40-41and 54-55 report the average value and the standard deviation of the difference 

between the pseudorange and the carrier phase measurements over the last minute. 
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3.1.8 TEC 

 

TEC and dTEC values (both in TECU unit) are provide in columns 17-24.   

 

Absolute TEC values are reported every 15 seconds (there are 4 TEC columns per ISMR record)  and 

are based on dual-frequency pseudorange measurements only.  dTEC values report the change of TEC 

over the four 15-s intervals during the last minute.  dTEC is computed from the carrier phase 

measurements only.  It is much more accurate than TEC, but only gives information on the TEC 

variation over time. 

 

Note that absolute TEC values can be biased by satellite and station inter-frequency biases.  Sources of 

station biases include the antenna, the antenna cable, splitters, amplifiers, and the receiver.  

 

For each constellation, the following table indicates which signals are used for TEC determination, 

and how the satellite biases are handled. 

 
Satellite 

system 

TEC signal 

combination  

Default handling of satellite-induced biases 

GPS(1) L1P-L2P  The correction (GD) transmitted by GPS satellites is applied. 

GLO L1CA–L2CA Uncorrected 

GAL E1–E5a The correction (BGD(E1,E5a)) transmitted by Galileo satellites is applied. 

BDS B1–B2 The correction (TGD1,TGD2) transmitted by BeiDou satellites is applied. 

QZSS L1CA-L2C The correction (GD) transmitted by QZSS satellites is applied. 

SBAS L1CA-L5 Uncorrected 
(1) For GPS, the TEC is based on the P-code measurements (as opposed to the C/A-code) on L1 and L2.  

Therefore, there is no need for correction of the L1P-L1CA satellite biases. 

 

It is possible to disable the correction of the satellite inter-frequency biases, i.e. to ignore the 

corrections transmitted by the satellites.  This is done by using the option “–g” of sbf2ismr (as of 

version 6.0.3). 

 

As of version 7.0.0, station biases (and residual satellites biases) can be provided in a TEC calibration 

file using the “–C” option of sbf2ismr.  See the help text at the beginning of this chapter for the 

TEC calibration file format.   sbf2ismr can be used to generate the calibration file.  See Appendix C 

for details. 

 

Note that, by default, the receiver does not apply any code smoothing, resulting in a noise on the TEC 

value of a few TECUs.  To reduce the noise at the expense of filtering short-term TEC variations,  

code smoothing can be enabled using the “setSmoothingInterval” command.  This remark 

does not apply to dTEC, which is computed on the basis of carrier phase measurements. 

 

 

3.1.9 Scintillation Index 

The SI index (columns 29, 43 and 57) is computed as follows: 

 

𝑆𝐼 =
10 log(𝑃𝑚𝑎𝑥) − 10log (𝑃𝑚𝑖𝑛)

10 log(𝑃𝑚𝑎𝑥) + 10log (𝑃𝑚𝑖𝑛)
 

 

Where Pmax is conventionally defined as the power amplitude of the third peak down from the 

maximum excursion over the 3000 samples in the last minute, and Pmin is the power amplitude of the 

third level up from the minimum excursion. 

 

Columns 30, 44 and 58 provide a modified scintillation index where only the numerator is computed 

(it is expressed in dB). 

 

 



 _________________________________________________________________________________ 3    sbf2ismr Program 

 

PolaRxS Application Manual v2.5.0  24 

3.1.10 Spectral Slope and Strength 

 

Columns 31, 45 and 59 provide the opposite of the slope (often noted “p”) of the phase PSD in log-log 

axes, where the PSD is obtained by computing the FFT of the 3000 detrended phase samples in the last 

minute.  The slope is computed by fitting a linear polynomial to the PSD over the 0.1 to 25Hz 

frequency range. 

 

The figure below illustrates the way the slope is computed.  In the example depicted, p is about 1.7. 

 
Next to the spectral slope, the spectral strength (often noted “T”) is provided in columns 60 to 62.  The 

spectral strength is the detrended phase power spectral density at 1.0Hz, i.e. the intercept of the linear 

polynomial described above. 

3.2 Monitoring the Current Scintillation Status with 
sbf2ismr 

Invoking sbf2ismr with the –S option produces a “status screen” output, which is handy to check 

the current status of the receiver and the level of the major scintillation indices.  When using the –S 

option, no ISMR file is created, only a status screen is produced. 

 

 
C:\sbf2ismr -S 

|---------------------------------------------------------------------------------------------------------------------------| 

| RxType: PolaRxS_PRO          SN:2003886               RxVersion:2.3-tst111205r33427   sbf2ismr-4.6.0x                     | 

| Time (GPS): 09:00:00  05 Jan 2012  (TOW:378000 WN:1669)                                                                   | 

|---------------------------------------------------------------------------------------------------------------------------| 

|PRN El     TEC | Sig    LT  C/N0   CCD TotS4 Phi60 | Sig    LT  C/N0   CCD TotS4 Phi60 | Sig    LT  C/N0   CCD TotS4 Phi60 | 

|   [deg] [TECU]|       [s][dBHz]   [m]       [rad] |       [s][dBHz]   [m]       [rad] |       [s][dBHz]   [m]       [rad] | 

|S24  7      -- |L1CA 11320  36.3  2.67  0.19  1.34 |  --    --    --    --    --    -- |  --    --    --    --    --    -- | 

|G20 61    22.6 |L1CA 13829  49.8  0.08  0.06  0.03 | L2C    --    --    --    --    -- |  L5    --    --    --    --    -- | 

|G23 50    25.2 |L1CA 11793  50.8  0.06  0.05  0.02 | L2C    --    --    --    --    -- |  L5    --    --    --    --    -- | 

|G31 16    32.8 |L1CA 18480  42.1  0.34  0.26  0.05 | L2C 18910  39.5  0.25  0.13  0.04 |  L5    --    --    --    --    -- | 

|G13 35    28.9 |L1CA  6297  48.4  0.15  0.10  0.03 | L2C    --    --    --    --    -- |  L5    --    --    --    --    -- | 

|G16 20    39.5 |L1CA  4075  42.3  0.28  0.16  0.03 | L2C    --    --    --    --    -- |  L5    --    --    --    --    -- | 

|G32 53    19.6 |L1CA 17439  50.7  0.09  0.08  0.03 | L2C    --    --    --    --    -- |  L5    --    --    --    --    -- | 

|R11 72    66.9 |L1CA  7058  49.1  0.13  0.06  0.03 |L2CA  6966  42.2  0.21  0.09  0.04 |  --    --    --    --    --    -- | 

|G07 18    12.2 |L1CA  2426  42.8  0.16  0.13  0.04 | L2C  2415  36.8  0.38  0.20  0.06 |  L5    --    --    --    --    -- | 

|G11 38    31.0 |L1CA 17724  48.3  0.07  0.10  0.03 | L2C    --    --    --    --    -- |  L5    --    --    --    --    -- | 

|G30 22    31.7 |L1CA  6491  44.3  0.13  0.07  0.03 | L2C    --    --    --    --    -- |  L5    --    --    --    --    -- | 

|S20 42      -- |L1CA 65534  43.0  0.58  0.07  0.56 |  --    --    --    --    --    -- |  --    --    --    --    --    -- | 

|R01 28    71.9 |L1CA  5624  45.0  0.22  0.22  0.08 |L2CA  4894  35.8  0.47  0.23  0.09 |  --    --    --    --    --    -- | 

|R08 42    39.2 |L1CA 16188  49.1  0.17  0.07  0.11 |L2CA 14929  46.8  0.17  0.07  0.08 |  --    --    --    --    --    -- | 

|S38 23      -- |L1CA 65534  44.5  0.80  0.06  0.45 |  --    --    --    --    --    -- |  --    --    --    --    --    -- | 

|R23 13    76.5 |L1CA 13454  44.2  0.27  0.15  0.08 |L2CA 13475  40.3  0.31  0.23  0.08 |  --    --    --    --    --    -- | 

|R12 22    75.8 |L1CA  2787  47.7  0.23  0.08  0.11 |L2CA  2546  42.7  0.21  0.08  0.09 |  --    --    --    --    --    -- | 

10
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|R07 13    73.5 |L1CA 25367  42.7  0.43  0.17  0.10 |L2CA 20359  42.4  0.27  0.10  0.08 |  --    --    --    --    --    -- | 

|S33 32      -- |L1CA 20553  42.3  0.83  0.08  0.50 |  --    --    --    --    --    -- |  --    --    --    --    --    -- | 

|R10 38    80.4 |L1CA 12821  48.9  0.19  0.07  0.04 |L2CA 12758  41.5  0.31  0.10  0.04 |  --    --    --    --    --    -- | 

|G01 59    22.7 |L1CA 15012  50.5  0.09  0.08  0.03 | L2C 14593  47.8  0.15  0.06  0.02 |  L5 14593  53.5  0.15  0.05  0.02 | 

|R24 16    60.5 |L1CA  7164  44.1  0.41  0.11  0.07 |L2CA  7164  42.4  0.35  0.22  0.06 |  --    --    --    --    --    -- | 

|E31 -- -1242.7 |L1BC 12346  46.9  0.10    --    -- | E5a 12346  46.8  0.08  0.05  0.16 | E5b    --    --    --    --    -- | 

|---------------------------------------------------------------------------------------------------------------------------| 

3.3 Parsing the Raw Data 

With the –r option, in addition to the ISMR file, sbf2ismr produces an ASCII comma-delimited 

file containing the raw phase and correlation values.  The format of this file is described in 

sbf2ismr’s help screen (see the screen dump at the beginning of this chapter).   

 

For example, to extract raw data from the SBF file test1.sbf, use the following command: 

 
C:\sbf2ismr –f test1.sbf –r out_ascii.txt 

 

The output file (out_ascii.txt in the example above) contains records such as the ones shown 

below: 

 
183601.00,101,20,98042793.214,119,11 

183601.00,13,0,120929967.314,-305,-2 

183601.00,2,0,120488916.249,258,-5 

183601.00,8,0,108470409.601,-890,0 

183601.00,10,0,107547455.595,806,0 

183601.00,4,0,133013504.780,-165,7 

183601.00,7,0,108677898.257,-836,-13 

183601.00,7,3,84684077.234,266,5 

183601.00,26,0,118815821.740,-323,-2 

183601.00,5,0,110675377.978,727,-27 

… 
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Appendix A 100-Hz Output Rate 
As described in the previous chapters, ionospheric monitoring typically involves sampling I&Q 

correlation and carrier phase data at a 50-Hz rate.  However, the PolaRxS also supports 100-Hz rate 

for advanced research. 

 

When operating at 100-Hz output rate, we recommend the following: 

 

 To prevent overloading the receiver’s CPU, the only SBF block that should be output at 100 

Hz is the IQCorr block. That block contains the I&Q correlation values and the carrier phase 

modulo 65.536 cycles.  To be able to reconstruct the full carrier phase at 100 Hz (i.e. to fix the 

65.536-cycle ambiguity), it is sufficient to log the MeasEpoch SBF block at a lower rate, e.g. 

1Hz.  

 

As of version 5.0.0, the sfb2ismr program, with the –r option, can be used to recover full 

carrier phase and correlation values from a SBF file containing 100-Hz IQCorr blocks and 1-

Hz MeasEpoch blocks.  See section 3.3 for details. 

 

 To avoid data gaps, it is recommended to use the receiver’s USB connection when operating at 

100-Hz.  Depending on the Ethernet network topology, streaming 100-Hz data over a TCP/IP 

connection may be unreliable. 
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Appendix B Real-Time ISMR 
 

As of firmware version 2.9, the PolaRxS contains a built-in real-time S4 and  monitor.  S4 and  

are computed every minute for all tracked satellites and signals (except GPS L2P), and are made 

available in the ISMR SBF block. 

 

Using the RxControl graphical interface, it is possible to view the S4 and  indices in real-time.  This 

is enabled in the View > Time Plots > Scintillation Indices Plot menu.  An example of real-time S4 

view is shown below. 
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Appendix C TEC Calibration 
Absolute TEC values can be biased by satellite and station inter-frequency biases.  Sources of station 

biases include the antenna, the antenna cable, splitters, amplifiers, and the receiver.   Satellite biases 

are compensated for when available (see section 3.1.8), but station biases need to be calibrated.  A 

procedure to do so is explained in this Appendix. 

 

As of version 7.0.0, sbf2ismr includes a tool for TEC calibration.  Calibration values can be 

computed for the TEC computed from GPS, Galileo, Compass/BeiDou, GLONASS and QZSS 

satellites. 

 

Calibration is done by comparing the measured TEC values (after correction of the satellite biases as 

documented in section 3.1.8) with reference TEC values.  The TEC reference can either be the SBAS 

ionospheric corrections, or the Klobuchar ionospheric model. The bias between the measured and the 

reference TEC values is averaged over several passes for each satellite individually, or for a whole 

constellation in case satellite biases are corrected.  A fixed elevation mask of 15 degrees is applied.   

 

To perform TEC calibration against SBAS, sbf2ismr must be invoked with the “-as” option.  To 

use the Klobuchar model as reference, the “-ak” option must be used. When using Klobuchar as 

reference, only the satellites tracked between 00:00 and 06:00 local time are considered, to avoid times 

of increased ionospheric activity.  The Klobuchar parameters are decoded from the GPS navigation 

messages. 

 

In regions covered by an SBAS system, it is recommended to calibrate against SBAS for better 

accuracy. 

 

The recommended procedure to generate a TEC calibration file is outlined below.  TEC calibration is 

most accurate in times of quiet ionospheric conditions.  If strong ionospheric activity is foreseen, it is 

preferable to delay the calibration procedure until a time of lower activity. 

 

1. Connect to the receiver using the RxControl graphical interface. 

 

2. In the File > Preferences menu, make sure that the SBF message interval is set to 1.0s (this is 

the default). 

 

 
 

 

 

 

 

 

 

 

 



 _________________________________________________________________________ Appendix C    TEC Calibration 

 

PolaRxS Application Manual v2.5.0  29 

 

3. Make sure that the receiver is in its default configuration.  This can be done by checking the 

“Config” option in the File > Reset Receiver menu: 

 

 
 

 

4. Navigate to the Navigation > Positioning Mode > SBAS Corrections menu and make sure the 

receiver is configured in MixedSystems navigation mode: 
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5. Under the Logging > RxControl Logging > SBF menu, enable the following SBF blocks for 

logging: MeasEpoch, PVTGeodetic, GEOCorrections, GPSNav, GPSIon, GLONav, 

GALNav, GEONav, QZSNav, CMPNav, ChannelStatus, ReceiverSetup. 
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6. In the File Naming tab, select manual file naming, and provide a file name: 

 

 

Note: the logging directory can be specified under the Global tab. 

 

7. Start logging by clicking the “Start Logging” button 

 

8. Collect data for at least 24 hours.  The longer the log file, the more accurate the TEC 

calibration.  Stop logging by clicking the “Stop Logging” button. 

 

9. Open a command window and run sbf2ismr in TEC calibration mode.  On Windows, 

sbf2ismr.exe can usually be found under C:\Program Files (x86)\ 

Septentrio\RxTools\bin. 

 

In regions covered by an SBAS system, use the option “–as” to generate TEC calibration 

values using SBAS ionospheric corrections as reference.  Otherwise use the option “-ak”.  

 

For example, assuming that the path to the log file collected in step 7 is 

P:\TECCalibrationLog.sbf, the sbf2ismr command and its output is shown below: 
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The output of sbf2ismr can be copied into a TEC calibration file without modification, and 

this file can be provided as TEC calibration input with the “-C” option of sbf2ismr (see 

section 3.1.8). 
 


